
Introduction to Cascade Server

(web content management system) Last Updated on Jul 14th, 2010

The College of Charleston's web site is being produced using a Content Management System (CMS) called Cascade
Server. This system allows College units to manage their own web areas using a browser-based tool that requires no
special software or knowledge of HTML. It also allows for a consistent look across the entire web site.

Logging in to Cascade Server

To log in, go to http://cannon (the CMS is available on campus only) and log in with your regular network login ID
& password. If you’ll be working in Cascade for more than a few minutes, check the “Remember me” box to avoid
being timed out and losing work. Only those who have been given access to Cascade can log in. To obtain access
please contact webmaster@cofc.edu.

The page you will see when you first log in to Cascade Server is the “dashboard” (not pictured). Most users will not
use most of what’s on this page except for the “Messages.” Most of your messages will be notes from the system
regarding something that you have published. You can read these messages and delete or keep them. To return to the
Dashboard at any time, click Home in the blue menu bar in the upper left corner of the screen.

The Cascade Server screen

The dropdown in the top left will indicate which sites you have access. The left-hand column lists all of the web site
folders you can access. Your website will be located in the "content" folder. To open a folder, click once on it.
There’s no double-clicking in this system. In the illustration below, the IT folder is open and you can see the other
folders and files that are inside of it. Those with the blue page icon: are web pages. Note that they do not have
".htm" or ".html" file extensions. The system will add the appropriate extension for you later, when you publish the
page (see pg. 8 for more). To view a file, click once on it. In the illustration, the file named index has been selected
and is shown on the right side of the window in "layout" view. Layout view is the default view that you get when
you click on a file. It shows you how the entire file looks, and includes some small icons which you can ignore.
"Preview" view is the same as Layout view, but without those icons. Notice the blue menu bar at the top (Home,
New, etc.), the tabs below (View, Edit, etc.), and the darker blue menu bar below the tabs (Layout, Preview, etc.).
These functions will be described later.
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Naming files & folders

Important: On the web, file and folder names are more restrictive than with regular files. In Cascade Server and on
any web server, file and folder names should contain only lower case letters, numbers, and if necessary, hyphens (-)
for spaces. Web file and folder names should never contain spaces! When naming files in Cascade Server, do not
put ".htm" or ".html" at the end (the system will add the appropriate extension when the page is published). Also,
note that Cascade Server does not allow you to have a folder and a file in the same location with the same name.
Finally, remember that your home page must be named "index" – do not rename this file!

Renaming files

If at all possible, try to permanently name files when you create them, so as to avoid renaming them later. If you do
rename a file, follow these steps to ensure that there are no “orphaned” files left on the server:

1. Unpublish the file you intend to rename:
◦ In the column on the left, click on the file you wish to rename, then click the Publish tab.
◦ Under Destination, leave both “Archdale” and “Ackerman” checked.
◦ Change the “Publish Mode” from Publish to Un-publish.
◦ Click the Submit button.

2. Rename the file:
◦ Click on the "Move/Rename" tab
◦ In the “System Name” box, change the name.
◦ Click the Submit button.

3. Publish the renamed file as described on page 7.

Creating new pages
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There are several options for creating a new page in cascade. The recommended approach is to create a "Folder with
Tertiary Index", you may also add pages inside of folder as well as pages with out the Marketing header.

To create a "Folder with Tertiary Index"
1. Select the folder in which you would like to create you new web page. The "content" folder is your

website's top level folder.
2. Click "New" from the top menu in blue.
3. Select "Folder with Tertiary Index"
4. This will then create a new folder for you. Please fill out the required filed: "Display Name", "Title" and

"System Name". See "Page Properties" and "Naming files and folder" below for more information.
5. Submit your changes.
6. Next go into the folder you just created and edit the "index" page. Please fill out the required filed:

"Display Name", "Title" and "System Name". See "Page Properties" and "Naming files and folder"
below for more information.

7. Don't forget to Publish your changes.

To add related pages inside of a folder that already exist.
1. Select the folder in which you would like to create you new web page. Please do not place page on the

"content" folder top level. The "index" page should be the only page on this level.
2. Click "New" from the top menu in blue.
3. Select "Tertiary Page" for a new web page with the Marketing header or "Tertiary Page - No Photo" for

a web page with out the marketing photo header.
4. This will create a new web page for you.
5. Please fill out the required filed: "Display Name", "Title" and "System Name". See "Page Properties"

below for more information.
6. Don't forget to Publish your changes. Please see "When to re-publish pages" below to see if you should

republish you entire folder or just the page.

Creating folders

1. In the column on the left, click on the folder inside of which you want the new folder.
2. In the blue menu bar at the top, go to New > Standard Folder.
3. In the “System Name” box (again, the bold, starred fields are the only ones required), enter a name for the

folder. See the “Naming files & folders” above for information on properly naming folders & files.
4. If you don’t want this folder to be published when the folder above it is published, uncheck “Include

when publishing.” You should do this for test folders & folders whose contents aren’t ready to go live
yet.

5. If you don't want this folder to show up in the navigation, uncheck "Include in Indexing"
6. Click Submit.

Deleting pages and files

To delete a page or folder:
1. Click on the file or folder you want to delete.
2. Click the "More" tab.
3. Under the "More" tab click "Delete".
4. Make sure "Unpublished" is checked.
5. Click "Submit".

Page properties

The top and left sides and right sides of each page are pre-defined – you cannot alter those areas except to specify
which pages appear in the navigation menu. The white area in the middle is your work area, where you will put your
text and
pictures. In editing mode, you will only see that part of the page (see illustration below).

To edit a page, click once on it on the left to view it, then click on the Edit tab. When the edit screen opens, the
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HTML code of the page will be displayed briefly. Just wait until it displays a screen like the one pictured below.

Below the Edit tab, shown here, you will see a dark blue menu bar with 4 options: Content, Metadata, System,
and Configurations. The important aspects of these options are described below.

Content: This is the main editing screen, where you create & edit the page content. On this screen you will also
find two very important boxes which must be filled in:

*Display Name: This is the name of the page that is used in the navigation menu on the left. It is not used
anywhere else. It may or may not be the same as the Title or Page Header (below).

*Title: This is the title of the page that displays in the web browser’s title bar, and is used when the page
is bookmarked. It will also be shown as the pages Header.

Metadata: Under Metadata, you can ignore everything except these item on Folders:

*Show Siblings in Navigation: If you don’t want to see the other folder around you current folder,
uncheck this. By default this is checked. For more about editing the navigation menu, see the
“Navigation menu” section on page 6.

System: Under System, you can ignore everything except:

*System Name: This is the actual file name of the page, minus the “.html” – again, the system will add
that
for you when you publish the page. This is where you would rename a page (see pg. 2 for details).

* Include when indexing: This means that you want the page or folder to show up in the navigation.
This is checked by default. A case where you might not want this checked would be when you are
creating an images or document folder. These folders usually hold files that will be referenced in a web
page and therefore do not need to be indexed.

*Include with publishing: Normally you will leave this checked. It means that the page will be
published to
the server (made live) if the folder that includes it is published. If for any reason you want to keep a page
from being published (e.g., if it’s not finished yet, or is just a test page), uncheck this box.
Include when indexing: Leave this checked.
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Configurations: Do not change anything on this screen!

*Starred items above are the various names each page can have, which can be somewhat confusing.

Saving you work

STOP! Be sure to save your work! In this system, it is very easy to lose your work because the system will not
warn you if you leave a page without saving first. You must be very careful that you click the Submit button before
clicking on another file or tab.

To save your changes, click the Submit button at the bottom of the screen (you may need to scroll down to see it). If
the spellchecker or link-checker come up, be sure to click Submit again after reviewing the results. Always
remember to save your work before leaving the screen you’re working on, e.g., if you need to refer to something on
another page, or want to preview the page. Cascade Server will not warn you if you leave a page you’re editing
without saving first; you will just lose your work.

Note that submitting a page only saves your changes in Cascade – it does not make them live on the web site. In
order to make your site or pages live, you must Publish them. (See the “Publishing” section on page 8.)

Versions

Cascade Server saves a version of the page each time you click Submit, so if something goes wrong, you can go
back to an earlier version of the page. This can be useful, but also means that you should only save when you’ve
actually edited the page. If you delete a page, all versions are deleted along with it, do NOT delete. To view the
available versions, with the date they were last modified and by whom:

1. Click once on the file on the left to view it, then click on the More tab and choose Versions.
2. To see another version, click on it in the Path column. To return to the Versions list, use your browser’s

Back button.
3. To compare an older version to the current one, click on Compare with Current.
4. To restore that version (make it the current version), click on Activate.
5. To go back to the current version without activating an older one, click on Current.

Comments: If you’re going to use the Versions, you may want to add comments when you edit pages. These
comments do not appear on your web page, but they are saved with the file and displayed in the Versions list.
You can use this for brief notes about why you edited the file, like “Updated staff listing.” To add comments, go
to the Edit screen and scroll down to the bottom. Click on the “Advanced Options » ” link and type your
comments in the “Version Comments:” box. Click the Submit button to save them.

Creating & editing page content

STOP! Please make sure you have read the brand manual before proceeding: http://marketing.cofc.edu/
brandmanual/webeleccomm/wc_reqpageelements.php

To edit a page, click once on it on the left to view it, then click on the Edit tab. When the edit screen opens, the
HTML code of the page will be displayed briefly; just wait until it displays a screen like the one shown on pg. 4.
When finished editing, click the Submit button at the bottom to save your changes. The editing and formatting tools
are very similar to those in Microsoft Word and other programs, so most of the buttons should be self-explanatory
(bold, italics, centered, etc.). If you’re not sure what a particular button does, hold your mouse pointer over it
without clicking. The “-- Styles --” and “-- Format --”drop-down menus contain formatting for headings and
subheadings.

Note: Please only use Headings 3 and below under the "Format" dropdown. Do not use headings 1 and 2.

To gain more screen space when editing, click the Toggle fullscreen mode button on the right side of the toolbar.
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Click it again to return to the normal view.
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Copying & pasting into Cascade Server

STOP! Do not copy & paste text from Word or web pages directly into Cascade. It will cause problems
with page formatting. Instead, use the techniques described here.

When you paste text into a page in Cascade, it will try to reproduce the
formatting of the copied text. It may look okay, but it will cause problems later
when you try to edit the page. To eliminate the unwanted formatting, use one
of the following techniques on Windows.

1. Copy the text you wish to paste into Cascade Server. This can be from a web page, Word, etc.
2. Open Notepad (Start – Programs – Accessories – Notepad).
3. In Notepad, go to Edit – Paste (or Ctrl+v). You will see your text without the formatting.
4. In Notepad, go to Edit – Select All (or Ctrl+a) to highlight the text. Go to Edit – Copy (or Ctrl+c) to copy

it.
5. On the Cascade edit screen, place your cursor where you want the text and go to Edit – Paste (or Ctrl+v).

Links

1. Select the text that you want to be linked (where people will click) and click the Insert/edit link button.

◦ To link to another page in Cascade Server, click the button. In the window that pops up,
select the page you want to link to and click the Confirm button.

◦ To link to an external (anything not in the current website you are working on) web site, click on
the External tab. In the “Link” box, type or paste the address of the page you want to link to.
Be sure to include the “http://” at the beginning.

◦ To link to an e-mail address, click on the External tab. In the “Link” box, type or paste the e-
mail address preceded by “mailto:” (without the quotes), e.g.,
mailto:webmaster@cofc.edu.

2. Do not change the “Target,” “Title,” or “Class” boxes.
3. Click the Insert button.

Linking within the same page (anchors)
1. To insert an anchor (the place on the page you wish to link to), put your cursor where you want the

anchor and click the Insert/edit Anchor button.

2. In the “Anchor name” box, type a name for the anchor with no spaces (e.g., myanchor) and click Insert.
3. The anchor will be represented by a little anchor icon, but it will not appear on the live version of the page.
4. To link to the anchor, highlight the text to be linked and click the Insert/edit link button.

5. On the Internal tab, in the “Anchor” box, type the name of your anchor (e.g., myanchor).
6. Click the Insert button.

Images

Uploading images
Images must be uploaded to Cascade before you can use them on a page. Put all image files in your “images”
folder. You can create subfolders inside of the “images” folder if you like. You can also upload multiple images
at once by putting them into a Zip file. Use the Zip Archive under Tools in the blue top bar to upload bulk images

1. In the column on the left, click on the images folder to highlight it.
2. In the blue menu bar at the top, go to New – file.
3. In the Data section, click the Browse button.
4. Choose the file and click Open.
5. Click the Submit button. When the upload is complete, you will see the name of the image appear in the

file list on the left and a preview of the image on the right.
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Inserting images

1. Be sure that you’ve already uploaded the image you wish to insert (instructions above), then open the
page in edit mode and click where you want the image.

2. Click the Insert/edit Image (tree)

button. In the window that pops up, click the orange Browse

button.
Another window will pop up for you to select the image.

3. In the column on the left, locate the image you want and click once on it. Click the Confirm button.
4. Back in the first pop up window, you must fill in the Alternate Text box. Alternate text should describe

the
image very briefly, e.g., “Main Hall” for a photo of Main Hall.

5. Always leave the Width/Height boxes blank. Images should be pre-sized before uploading. Images
should be no wider than 500px. Use the Alignment box to change the alignment of the image and how the
text wraps around it. We recommend using : Left or Right.

6. Click the Insert button.
7. To edit an image after it has been inserted, click on the image, then click the Insert/edit Image

button.

Uploading PDFs & other non-html files
PDF files have to be uploaded to Cascade Server before you can use them on your site. If there are other types
of non-web page files that you need for your site, you would upload them in the same way.

1. In the column on the left, click on the folder in which you wish to put the file.
2. In the blue menu bar at the top, go to New – file.
3. In the Data section, click the Browse button.
4. Choose the file and click Open.
5. Click the Submit button. When the upload is complete, you will see the name of the image appear in the

file list on the left, and Cascade Server should display the file on the right side.

If you need to upload a new version of a PDF, click on it on the left, click the Edit tab, and repeat steps 3-5.

Bulk Uploading Files

1. Zip up the files you'd like to upload.
2. Click on the folder inside the CMS you'd like to upload into.
3. Click "Tools" on the main navigation then click "Zip Archive"
4. Select your zip file form you computer.
5. Your files will then be uploaded and unzipped into the folder you selected.

Navigation menu

You cannot control the navigation menu directly; you do so through the properties of the
pages in the folder. Whether or not a page appears in the navigation menu is controlled by the “Include in
Navigation” option on the System screen. If that’s set to Yes (the default), the page’s “Display Name” will
appear on the navigation menu for all pages in that folder. To change the order of items in the navigation menu:
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Page Order
1. In the column on the left, click on your folder.
2. On the right, you will see a list of the folders and files in your main folder. To sort them by order number

(2nd column), click on the word Order at the top of that column.
3. The items with the page icons are your web pages. The order that they’re in in this list is the order in

which they appear on the navigation menu. To change the order, click the arrows in the Actions column to
move pages up or down. You can also drag and drop the pages.

Note: If you rearrange the navigation menu or do anything else that affects it (e.g., deleting a page, changing
the Display Name of a page, adding a page, etc.), the system will automatically update all of the necessary
pages, but in order for the updates to be made live on your site, you must republish all of the effected pages or parent
folder.

Publishing

Submitting a page only saves it in Cascade Server – it does not make it live on the College of Charleston web site. In
order to make pages live, you must publish them. Any time you make a change to your folder or page(s) in Cascade
Server, you must republish all effected pages in order for the change to be live.

How to publish

1. To publish one file, click on it in the column on the left, then click the Publish tab.
2. Leave "Archdale" and "Ackerman" checked in the Destinations Both sites are checked by default.
3. Leave the “Generate a publish report message” box checked and click the Submit button.
4. To publish more than one file at the same time click on the folder, then on the right side, check the boxes

next to the files you wish to publish. At the bottom of the file list, from the “With Selected:” drop-down
menu, choose Publish. When it asks “Are you sure you want to publish these # assets?”, click Submit.
*Please do not publish your entire department folder unless necessary, as that creates a lot of unnecessary
extra work for our servers.

When to re-publish pages

STOP! Be sure to re-publish all of the affected pages when you:
• add a page to the navigation menu
• delete a page that was on the navigation menu
• change the Display Name of a page on the navigation menu
• change the order of items on the navigation menu

When to re-publish pages
Whenever you change anything that affects the navigation menu, Cascade Server will automatically update all of the
necessary pages, but then you must re-publish all of the pages containing that navigation.

Assistance and questions

If you have any technical questions or if you need more information, contact the Webmaster at
webmaster@cofc.edu. If it's urgent you can contact us at 953-8155. For question about content on your website
please contact Marketing at stoudenmirel@cofc.edu.

Also please check http://webdev.cofc.edu/ for updated versions of this document.
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